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Thematic Mapping – the display of data on a map

Chloropleth Graduated Symbol Dot Density

Enrollment by County

Enrollment by Country

Location of Distance Ed Students

Enrollment by Level and State
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A few definitions
• Geoset – A geoset contains geographic 

information needed to draw a map.  When a 
map based on a geoset is drawn, the tables 
appear as layers in the map.

• Data Binding – The linking of data to a map

• FIPS – Federal Information Processing 
Standards

Step-through the creation of a map for 
Enrollment by County for Texas

(See SPSS Maps How-To Handout)



SPSS Maps How-to 
TAIR 29th Annual Conference - February 2007 

Creating a Texas Geoset 
A geoset contains geographic information needed to draw a map.  When a map based on a geoset is 
drawn, the tables appear as layers in the map.1
 

• Open the SPSS Geoset Manager 
o Start > SPSS > Geoset Manager 

OR 
o Navigate to C:\Program Files\SPSS\Maps\geosetmanager40.exe 

• Open the US map (filename: US.GST) 
o Note: the file can be found in the Maps folder within ProgramFiles\SPSS. 

• To protect the original file, save the map under a different name within the Maps folder 
o Change the Geoset Name (text box in the toolbar) to Texas 
o File > Save As 
o Name the file Texas 
o Click Save 

• Change the projection of the map 
o Map > Projection… 
o Under Category, select Regional Mercator Systems 

 This will give the map a flat appearance 
o Under Category Members, select Mercator 60 
o Click OK 

• Focus on Texas 
o Select the Zoom In ( ) tool 
o Using this tool, draw a square around the state of Texas 
o Select the Hand tool ( ), and center the map 

• Edit the county map layers 
o Map > Layer Control… OR select the Layer Control ( ) tool from the toolbars 
o Under Layers, select US County Boundaries, and click Display 
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o Check Display within Zoom Range 
o Change Max Zoom to 50,000 (no comma) 

 Doing this allows you to see the county borders 
 

      
 

o Within the Display Properties window, check Override Style (see illustration above) 
o Click the Display Mode button (to the right of Override Style) 
o Select a Map Color 

 Within the Pattern drop-down menu, select the Solid Black square (next to N) 
 Within the Foreground drop-down menu, select Light Grey 

• Selecting a subtle color, such as light grey for the overall map will make 
allow counties to stand out once data is added. 

 

 
  

o  Select a Border Style 
 Within the Style drop-down menu, select one of the Dotted Line styles 
 Within the Color drop-down menu, select Dark Grey 

 
 Click OK in the Region Style window 
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o Click OK in the Display Properties window 
• Edit the areas surrounding Texas 

o Reopen the Layer Control window 
o Under Layers, select Mexico, and click Display 
o Within the Display Properties window, check Override Style  
o Click the Display Mode button (to the right of Override Style) 

 Within the Pattern drop-down menu, select the Solid Black square (next to N) 
 Within the Foreground drop-down menu, select Light Grey 

• All the above steps give Mexico the same appearance as the United States 
counties.  It is necessary to retain Mexico as a layer, so the southwest 
border of Texas is visible. 

o Click OK twice 
o Under Layers, select US Top 20 Cities, and uncheck Visible within the Properties box 

 Repeat the above step for US Capitals, US Major Cities, US Cities, US 5 Digit 
Zipcode Centers, US Highways, and USA 

 This will remove these layers from the map, allowing focus to remain on the 
counties. 

 

 
 

o  Under Layers, select Ocean, and click Display 
o Click the Display Mode button (to the right of Override Style) 

 Change the Ocean color to a lighter color 
o Click OK twice 

• Save the geoset 
• Exit Geoset Manager 
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Creating a Data File 
The date file will contain geographic information as well as the information you want to map.  For the 
purpose of this demonstration, we will create a data file containing county names and their respective 
enrollments.  To avoid name mismatches, we will use a county file provided by SPSS and add 
enrollment data to it.  We will also create our own value ranges for the data.  Different maps may require 
different data formats. 

 
• Open the SPSS County file 

o Open > C:\Program Files\SPSS\MapsData\County Age Demographics by Gender 
• To protect the original file, save the data under a different name 
• Remove all non-Texas data 

o File > New > Syntax 
 Type: FILTER OFF. 

USE ALL. 
SELECT IF (st_fips=’48’). 
EXECUTE. 

 Run > All (on the menu bar) 
OR  

o  Data > Select Cases 
 Check If condition is satisfied, then click the  If… button 
 Type st_fips=’48’ in the text box, and click Continue 
 Under Unselect Cases Are, select Deleted 
 Click OK 

o Under Variable View (Ctrl+T), select and clear all columns except cnty_fip, county, 
st_fips, and state 

• Add enrollment data 
o Under Variable View, add the variable enrollment 

 

 
 

o Under Data View, add the enrollment for each county listed 
 Manually enter the number for each county 

OR 
 Copy and paste data from Excel 

• Note: Make sure data is sorted by county and that numbers do not 
contain commas. 
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• Create data ranges 

o This will create a new column containing the enrollment range for each county. 
o Transform > Visual Bander 
o Move enrollment from the Variables box to the Variable to Band box 
o Click Continue 
o Select enrollment from the Scanned Variable List box 
o Under Banded Variable, in the Name and Label textboxes, type EnrollmentGroup 
o Click Make Cutpoints… 

 Check Equal Width Intervals 
 First Cutpoint Location: 0 
 Number of Cutpoints: 6 
 Click Apply 

o Under Value enter the following information (see illustration below):  
1) 0 
2) 10 
3) 100 
4) 500 
5) 1000 
6) 2000 
7) HIGH 

o Under Upper Endpoints, check Included (<=) 
o Click Make Labels 
o Click OK 
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• *LEGEND WORK-AROUND* 

o If you generate an Individual Value map using the variable EnrollmentGroup, the 
legend SPSS generates will be out of order and look similar to this: 

 
Individual values EnrollmentGroup

by EnrollmentGroup

1 - 10   (133)
1001 - 2000   (2)
101 - 500   (2)
11 - 100   (36)
2001+   (1)
501 - 1000   (2)
<= 0   (78)

 
 

o To create a legend that reads in ascending order, you must recode EnrollmentGroup 
 Transform > Recode > Into Different Variables 
 Move EnrollmentGroup to the Numeric Variable -> Output Variable box 
 In the Name and Label textboxes type category 
 Click Old and New Values 

 

 
  

 Under Old Value, in the Value text box, type the number 1 
 Under New Value, in the Value text box, type the number 7 
 Click Add 
 Continue this process for the rest of the variables (see illustration below) 
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 Click Continue 
 In the Recode into Different Variables window, click Change 
 Under Variable View (Ctrl + T), change the number of Decimals for category 

to 0 
 Save 

• Note: If you plan on creating enrollment maps often then you can 
paste the Visual Bander and Recoding processes shown above to 
syntax.  Just click the Paste button instead of the OK button. 
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Creating a Map 
Since we created our own range, we will be making an individual values map.  If you would like SPSS 
to create a range for your data, create a Range of Values (Graphs > Map > Range of Values…) map and 
use enrollment as your defining variable. 
 

• Open your data file (created within “Creating a Data File” above) 
• Graphs > Maps > Individual Values… 

o Under Individual values for:, drag-and-drop category 
o Under Geoset, select Texas (created earlier in this How-To) 
o Under Geographic Variable:, drag-and-drop 5-Digit County FIPS Code [cnty_fip] 

 

    
  

o Select the Advanced tab from within the Create Individual Values Map window (see 
illustration above) 

o Under Variables to refine geographic match, drag-and-drop County Name [county] 
o Under Map Layer, select US County Boundaries 
o Check Show geographic labels 

 This step is very important!  If you do not check Show Geographic Variables, you 
will not be able to label your map. 

o Click OK 

Texas Woman’s University    

Institutional Research    8 
940-898-3021 | irsfactbook@twu.edu | www.twu.edu/irp     



SPSS Maps How-to 
TAIR 29th Annual Conference - February 2007 

Editing a Map 
Creating a map can help people visualize data; however, the purpose of a map may be lost if it is not 
readable.  The final look of a map falls on user preference.  Below are some methods and techniques to 
help you create a visually aesthetic map. 
 

• Remove the map title 
o Double-click the map in your output viewer 

 This action creates a toolbar at the top of your map 
o Select the Zoom In ( ) tool 
o Using this tool, draw a square around the state of Texas 
o Select the Hand tool ( ), and center the map 

 You may want to enlarge your entire map for easier editing 
o Click Edit Map Title on the toolbar 

 

 
  

o In the Edit Map Title window, uncheck Map Title is Visible 
o Click Close 

• Change the theme colors and patterns of Texas counties 
o Click Themes on the toolbar 
o Under Themes, select Individual Values 
o Click Display 

 

 
  

o Under Individual Value, select the lowest value (should be 1.000000) 
 Note: After recoding the variables, the lowest value you your scale represents the 

counties with the highest enrollment.  The Legend will be adjusted to show this in 
a later step. 
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 Click Region Style (see illustration below)  

 

 
  

 Under Pattern, select the Solid Black square 
 Under Foreground, select the darkest color you would like for your map 

• Note: As stated earlier, this will represent the county with highest 
enrollment. 

 Click OK 
o Under Individual Value, select the next value (2.000000) 

 Note: For each lesser enrollment range, you will want to select a lighter color 
and possibly a pattern to help differentiate from other ranges. 

 Click Region Style 
 Under Pattern, select a pattern of your choosing 
 Under Foreground, select a lighter color than the previous value 
 Under Background, choose a color to go with your foreground 

• Note: It make take several attempts to find colors and patterns that agree 
with your map. 

 

 
 

 Click OK 
o Repeat the above steps for each Individual Value, varying the color/patterns into lighter 

shades. 
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• Create Labels 

o Click Map Layers on the toolbar 
 

 
  

o Under Layers, select US County Boundaries, click Labels 
o Within the DataSet drop-down menu, select DataSet5 
o Within the Field drop-down menu, select County Name 
o Check Display within Range 
o Set Min Zoom to 0 and Max Zoom to 50,000 (no commas) 
o Check Allow Overlapped Text 
o Uncheck Allow Duplicated Text 
o  Click Text Style (see illustration below) 

 

 
  

o Under Font, select Verdana and size 4 
o Under Text Color, select black 
o Under Background, select Halo and choose Color white 
o Uncheck Bold  
o Uncheck All Caps 
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o Click OK three times 

• Modify the legend 
o Click Themes on the toolbar 
o Under Themes, select Individual Values 
o Click Legend 
o Change Title, Compact Title, and Subtitle as needed 

 Note: To save on space, you can eliminate all titles, leaving simply the range of 
values key. 

o Under Legend Text, select 1.000000  
o Change the value in the textbox to 2001+ 
o Continue the above steps for each Individual Value, changing the values to the 

appropriate ranges 
 Warning: Modify your legend at the end.  SPSS will not save the values, so should 

you close the map, you will lose legend changes. 
 

 
  

Exporting to Other Software 
Additional modifications can be made in word processing and image editing software by copying and 
pasting the map into these other applications.  You can also print a map to PDF. 
 
 
 
 
 
 
 
1SPSS Training Department.  Introduction to SPSS Maps.  Chicago.  2000. 
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2001 +   (2)
1001 - 2000   (2)
501 - 1000   (1)
101 - 500   (4)
11 - 100   (37)
1 - 10   (126)
= 0   (82)
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SPSS Maps Add-on

• Pricing

– Version 10 - $299

• Upgrade - $60

– SPSS 15 - $319

Alternatives to SPSS
• ArcGIS

– Full-featured
– Requires training ($300)
– Free to try; $250 for education license
– www.esri.com/software/arcgis/

• Microsoft MapPoint
– Integrate with MS Office
– North America only
– Free to try; $299 to purchase
– www.microsoft.com/mappoint/

• History
– Wikipedia

http://en.wikipedia.org/wiki/Thematic_map

– Edward R. Tufte
http://www.edwardtufte.com/tufte/

• Color Choices
– Color Brewer

http://www.personal.psu.edu/cab38/ColorBrewer/ColorBrewer_intro.html

Other Resources
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Contact

Kate Amorella
Senior Research Analyst

940-898-3013
kamorella@twu.edu

Tracy Stegmair
Senior Research Analyst

940-898-3021
tstegmair@twu.edu

www.twu.edu/irp
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